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Introduction 

This document is intended for CATIA V5 Administrators only. It is assumed that the C3PNG 

compliant version of CATIA V5 is already installed and licensed correctly. It is also assumed 

that the installation process is undertaken by someone with the correct Administrator level 

access authority. 

Installation Prerequisites 
The following base packages are required to install the Ford Supplier C3PNG Release JT to 

CATIA V5 Interface 

CATIA V5-6R2020 (R30) 

Please refer to the Ford Supplier website to identify the specific Service Pack & Hotfix 

version level to be installed. Using the translator external to CATIA V5 only requires a 

minimum of CATIA V5 R30 GA. 

The JT-CATIA V5 interface makes use of a combination of both CATShape and CGR data to 

graphically represent the JT data that is inserted in the assemblies. The ability to create data 

of these types is enabled by the inclusion of the CATIA V5 ‘CNA - Compartment and Access 2 

Product' module. Therefore ensure that this package is installed into your installation. 

CNA - Compartment and Access 2 Product 

Managing the Conflict between Ford & Dassault Systemes JT-V5 Multi-

CAD Architecture 

Important Note 

With the introduction of CATIA V5-6R2020 Dassault Systemes are delivering their basic 

Multi-CAD infrastructure as part of the base CATIA V5 installation. The basic DS Multi-CAD 

infrastructure causes a conflict with the Ford JT to V5 mechanism when running inside of the 

CATIA application. Therefore it is necessary to disable the basic DS Multi-CAD environment 

prior to running the Ford processes. This is achieved by simply renaming one of the DS 

supplied DLL files (CATMCIArchitecture.dll) located within the bin folder of the CATIA V5 

installation. Scripts are provided to perform both the task of managing this conflict by simply 

renaming the DLL file in its original location.  

Therefore as an Administrator user you can run the following scripts; 

 %TS_INST%\bin\disable_v5r30_CATMCIArchitecture.cmd – this scripts renames the 

DLL and therefore allows the Ford Multi-CAD process to operate interactively within 

CATIA V5 

 %TS_INST%\bin\enable_v5r30_CATMCIArchitecture.cmd – this scripts restores the 

DLL to its original name therefore allowing the DS Multi-CAD process to operate 

interactively within CATIA V5 and disables the Ford Multi-CAD process from 

operating 
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Microsoft Visual C++ Redistribution Requirements for Windows 

Important Note 

This version of the translator is based upon CATIA V5, JT Open and other third party libraries. 

Consequently for Windows users there is a pre-requisite to install the VC++ Redistribution 

libraries associated with the API releases. A number of executables are provided to install 

these libraries in the directory named %TS_INST%\VCREDIST of the installation. As a user 

with System Administrator privileges simply execute the all of the files in the VCREDIST 

directory. This will install the necessary libraries onto your machine.  

Note, other applications that also have the same dependency of this Microsoft VC++ 

application may have already installed the libraries onto your machine. In this case installing 

the libraries for a second time will not have a detrimental impact on your machine. 

Therefore in these circumstances you may elect not to install the libraries for a second time. 

Copies of the files that must be installed, if not previously installed, at this release are 

named; 

 %TS_INST%\vcredist\vc8\vcredist_x64.exe Microsoft Visual C++ 2005(X64) 

 %TS_INST%\vcredist\vc8\vcredist_x86.exe  Microsoft Visual C++ 2005(X86) 

 %TS_INST%\vcredist\vc9\vcredist_x64.exe  Microsoft Visual C++ 2008(X64) 

 %TS_INST%\vcredist\vc9\vcredist_x86.exe  Microsoft Visual C++ 2008(X86) 

 %TS_INST%\vcredist\vc10\vcredist_x64.exe Microsoft Visual C++ 2010(X64) 

 %TS_INST%\vcredist\vc10\vcredist_x86.exe Microsoft Visual C++ 2010(X86) 

 %TS_INST%\vcredist\vc11\vcredist_x64.exe Microsoft Visual C++ 2012(X64) 

 %TS_INST%\vcredist\vc11\vcredist_x86.exe  Microsoft Visual C++ 2012(X86) 

 %TS_INST%\vcredist\vc12\vcredist_x64.exe Microsoft Visual C++ 2013(X64) 

 %TS_INST%\vcredist\vc14\vcredist_x64.exe Microsoft Visual C++ 2015(X64) 

 %TS_INST%\vcredist\vc14\vcredist_x86.exe Microsoft Visual C++ 2015(X86) 

 %TS_INST%\vcredist\vc141\vcredist_x64.exe Microsoft Visual C++ 2017(X64) 

 %TS_INST%\vcredist\vc141\vcredist_x86.exe Microsoft Visual C++ 2017(X86) 

Supported Operating Systems 
The following list operating systems are supported by the C3PNG JT to CATIA V5 Interface. 

 Windows 10 
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Obtaining the Software 
Installation packages are available for the specified operating systems. These packages can 

be obtained from the Theorem Solutions Ford Supplier software distribution website 

https://www.theorem.com/ford-suppliers  

Alternatively this site can be accessed directly through the Ford supplier web pages  

The download packages are named  

 theorem_21.3.001.zip – For Windows 10 users 

Copies are available for distribution by CD if required, contact either Theorem Solutions or 

your Theorem Solutions software reseller and a CD will be sent to you directly.  

Disk Space Requirements 
The overall disk space requirements to install the translator are dependent upon the 

operating system used. Therefore the following list identifies the disk space required for 

each operating system supported. 

 Windows 10 = 550 Mb 
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Installation Process 

Installation Directory 
It is assumed that CATIA V5 installation is located in the directory C:\Program Files\Dassault 

Systemes\B30. During this process a new directory named theorem will be created within 

the C:\Program Files\Dassault Systemes\B30 directory. Therefore the default installation 

directory will be named C:\Program Files\Dassault Systemes\B30\theorem. 

The software may be relocated into an alternate directory structure of your choice. However 

please contact Theorem Solutions for guidance before installing the software into an 

alternate directory structure.  

Installation Process for Windows 
Copy the installation package into the installation directory C:\Program Files\Dassault 

Systemes\B30 

Extract the files from the installation package “theorem_21.3.001.zip “ 

The initial installation directory name will be named theorem_21.3.001. Rename this 

directory to become theorem such that the directory named C:\Program Files\Dassault 

Systemes\B30\theorem contains sub-directories with names such as bin, flexlm, JAVA etc. 

The following edits need to be made to the CATEnv file that is used within CATIA V5. The 

standard CATEnv file for C3PNG release is named  

C:\ProgramData\DassaultSystemes\CATEnv\CATIA_V5R30_CAA.FEDE.txt  

Update this environment file and add or modify the following settings 

TS_INST – Set the path to the Theorem translator installation 

 TS_INST= C:\Program Files\Dassault Systemes\B30\theorem 

TS_CGR_TYPE – Sets the type of CGR output required. Available settings are QUICK, 

BREP_FACET or PRECISE. For information regarding the settings refer to the JT – CATIA V5 

Command Line Reference Guide 

 TS_CGR_TYPE=QUICK  

TS_CFILE_VIS – Location of the translator configuration file used for CGR creation. Note the 

name should match the setting used for the TS_CGR_TYPE. Therefore available settings are; 

 jt_read_visualization_quick.config 

 jt_read_visualization_brep_facet.config 

 jt_read_visualization_precise.config 

 TS_CFILE_VIS=%TS_INST%\etc\jt_read_visualization_quick.config 

TS_CFILE_DES – Location of the translator configuration file used for CATShape creation 
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 TS_CFILE_DES=%TS_INST%\etc\jt_read_design.config 

THEOREM_LICENSE_FILE – Location of the Theorem Solutions license server 

 THEOREM_LICENSE_FILE=7601@license_server_hostname 

TS_V5PATH – Set the path to the Theorem CATIA V5 extensions 

 TS_V5PATH=%TS_INST%\B30\win_b64 

PATH – Add the path for the translator to the existing path setting 

 PATH=%TS_V5PATH%\code\bin;C:\Program Files\Dassault Systemes\B30\…… etc 

CATDLLPath – Add the path to the translator to the existing path setting 

 CATDLLPath=%TS_V5PATH%\code\bin; C:\Program Files\Dassault 

Systemes\B30\…… etc 

CATDictionaryPath– Add the path to the Theorem dictionary to the existing path setting 

 CATDictionaryPath=%TS_V5PATH%\code\dictionary;C:\Program Files\Dassault 

Systemes\B30\…… etc 

 

Example Windows CATEnv File 
The following example CATEnv file shows a default example file for the Windows platform 

with the specified edits highlighted in BLUE text.  

Note this file has a sequential logically dependency structure. Therefore the setting of a 

variable, e.g. TS_INST=C:\Program Files\Dassault Systemes\B30\theorem must precede the 

usage of the variable e.g. TS_CFILE_DES=%TS_INST%\etc\jt_read_design.config. CATIA V5 

will not operate correctly if this rule isn’t adhered to. 

!---------------------------------------------------------- 

! DASSAULT SYSTEMES - V5 ENVIRONMENT FILE 

!---------------------------------------------------------- 

! MODE : Global 

! TYPE : CATIA 

! TMSTMP : 1139570754 

!---------------------------------------------------------- 

TS_INST=C:\Program Files\Dassault Systemes\B30\theorem 

TS_CGR_TYPE=QUICK 

TS_CFILE_VIS=%TS_INST%\etc\jt_read_visualization_quick.config 

TS_CFILE_DES=%TS_INST%\etc\jt_read_design.config 

THEOREM_LICENSE_FILE=7601@license_server_hostname 

TS_V5PATH=%TS_INST%\B30\win_b64 

CATInstallPath=C:\Program Files\Dassault Systemes\B30\win_b64 

CATDLLPath=%TS_V5PATH%\code\bin;C:\Program Files\Dassault 

Systemes\B30\win_b64\code\bin 

CATICPath=C:\Program Files\Dassault Systemes\B30\win_b64\code\productIC 
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CATCommandPath=C:\Program Files\Dassault Systemes\B30\win_b64\code\command 

CATDictionaryPath=%TS_V5PATH%\code\dictionary;C:\Program Files\Dassault 

Systemes\B30\win_b64\code\dictionary 

CATDocView=C:\Program Files\Dassault Systemes\B30\win_b64\doc 

CATReffilesPath=C:\Program Files\Dassault Systemes\B30\win_b64\reffiles 

CATFontPath=C:\Program Files\Dassault Systemes\B30\win_b64\resources\fonts 

CATGalaxyPath=C:\Program Files\Dassault 

Systemes\B30\win_b64\resources\galaxy 

CATGraphicPath=C:\Program Files\Dassault 

Systemes\B30\win_b64\resources\graphic;C:\Program Files\Dassault 

Systemes\B30\win_b64\resources\graphic\icons;C:\Program Files\Dassault 

Systemes\B30\win_b64\resources\graphic\figures;C:\Program Files\Dassault 

Systemes\B30\win_b64\resources\graphic\splashscreens;C:\Program 

Files\Dassault Systemes\B30\win_b64\resources\graphic\symbols;C:\Program 

Files\Dassault Systemes\B30\win_b64\resources\graphic\textures 

CATMsgCatalogPath=C:\Program Files\Dassault 

Systemes\B30\win_b64\resources\msgcatalog 

CATFeatureCatalogPath=C:\Program Files\Dassault 

Systemes\B30\win_b64\resources\featurecatalog 

CATDefaultCollectionStandard=C:\Program Files\Dassault 

Systemes\B30\win_b64\resources\standard 

CATStartupPath=C:\Program Files\Dassault Systemes\B30\win_b64\startup 

CATW3ResourcesPath=C:\Program Files\Dassault Systemes\B30\win_b64\docs 

CATReferenceSettingPath= 

CATUserSettingPath=CSIDL_APPDATA\DassaultSystemes\CATSettings 

CATCollectionStandard= 

CATTemp=CSIDL_LOCAL_APPDATA\DassaultSystemes\CATTemp 

CATMetasearchPath=DSKEY_TMPDIR 

CATW3PublishPath=DSKEY_TMPDIR 

CATSharedWorkbookPath=DSKEY_TMPDIR 

CATErrorLog=CSIDL_LOCAL_APPDATA\DassaultSystemes\CATTemp\error.log 

CATReport=CSIDL_LOCAL_APPDATA\DassaultSystemes\CATReport 

CATDisciplinePath= 

USER_HOME=CSIDL_PERSONAL 

JAVA_HOME=%JAVA_HOME% 

CLASSPATH_JDBC= 

CLASSPATH=%CLASSPATH_JDBC%;%CLASSPATH% 

PATH=%TS_V5PATH%\code\bin;C:\Program Files\Dassault 

Systemes\B30\win_b64\code\bin;C:\Program Files\Dassault 

Systemes\B30\win_b64\code\command;%JAVA_HOME%\bin;%PATH% 

Configuring the Translator to run from the Command Line 
Having installed the software in the default installation directory of C:\Program 

Files\Dassault Systemes\B30\theorem you’ll find a file named ts_env.bat. When running 

the translator from the command line various system settings are obtained from data within 

this file. This data enables the translator to locate the correct CATIA V5 settings that are 

being used as well as confirming the actual software installation location. If you’ve decided 

to install either CATIA V5 or the translator into an alternate directory location then it will be 

necessary to edit this file and change the default settings to reflect your actual installation. 

The default values found in the supplied ts_env.bat file are; 

set CATIAV5R30_INST=C:\Program Files\Dassault Systemes\B30 

set CATIAV5_ENV=CATIA_V5R30_CAA.FEDE 

set CATIAV5_DIRENV=C:\ProgramData\Dassault Systemes\CATEnv 

set TS_INST= C:\Program Files\Dassault Systemes\B30\theorem 
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set TSC_TEMP_DIR=%TEMP% 

set THEOREM_LICENSE_FILE=7601@license_server_hostname 

 

Note: You will need to edit the supplied ts_env.bat file and uncomment the setting for 

THEOREM_LICENSE_FILE. Then change the value of the variable license_server_hostname to 

be the actual hostname of the machine used as the license server 

The Translator Configuration File 
When running the translator in the Catia5 interactive mode options are able to be invoked 

by using the translator configuration file. These files are referenced in the CATenv file using 

the TS_CFILE_DES and TS_CFILE_VIS settings. The configuration file is a simple text file 

containing a number of command line translator options, one option per line of the 

configuration file. 

A Ford recommended JT Read Design configuration file is delivered as part of the software 

distribution. The filename is %TS_INST%\etc\jt_read_design.config and contains the 

following translator settings;  

read_pmi 

dont_print_info 

assemble_faces 

edge_curves 

dont_map_layers 

noinfo 

nowarnings 

off_ditto 

For additional information please refer to the JT – CATIA V5 Command Line User Reference 

Guide for a detailed definition of these specified options.  
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License Management 

This outlines FLEXlm based licensing for Windows users. The information below defines how 

to use the FLEXlm license mechanism with the any of the Theorem Solutions CADverter 

software products. 

Loading the FlexLM Software 
The FLEXlm software is loaded automatically during software installation. 

The License File 
To obtain a valid license file you must supply the output generated when using the 

theorem_composite executable located in the flexlm directory of the installation. An 

example of the output generated is shown below. 

Send a copy of the output generated to your software vendor to enable the license to be 

created. 

Your license file will usually be sent to you by E-mail or if necessary by FAX It will contain 

other text such as instructions on how to load it; this text will not affect the running of the 

license file. 

If you receive the file by FAX you will need to use any text editor to enter the data. 

An example license file is shown below: 

SERVER server1.theorem.com COMPOSITE=18642C02FFCF 7601 

DAEMON theorem c:\theorem\flexlm 

INCREMENT DirectModel_Catia5_eval theorem 15.0 24-oct-2012 \ 

1 37CA284B337E VENDOR_STRING=<license_type_purchased> \  

ck=87 SIGN=354805646156 

Only the important lines are shown in this example. They are split up into three types: 

SERVER followed by the HOSTNAME server1.theorem.com), the COMPOSITE HOSTID 

(COMPOSITE=18642C02FFCF) and the PORTID (7601). The COMPOSITE HOSTID and the 

HOSTNAME must match output generated from the theorem_composite executable when 

run on your license server machine. If you change your processor then the license will no 

longer function and must be re-cut by your software provider. 

DAEMON followed by the path to the License server daemon executable. If you have 

installed the CADverter software in a path other than /usr/theorem then you must edit this 

line to reflect the location of the flexlm/theorem file. 

INCREMENT followed by the feature name (e.g. DirectModel_Catia5) and other license data 

to protect the feature. These lines must not be edited or the FEATURE will not work. 

Note: text may be wrapped over more than one line. When this occurs the continuation 

character is denoted by a '\'. The continuation line must then start with a 'tab' character. 

Once the license file has been installed you may start the license manager. 
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License Manage Utility 
Use the FLEXlm utility lmtools located in the %TS_INST%\flexlm directory for all license 

functions on Windows. 

FlexLM Documentation 
The FLEXlm License manager software package contains a complete set of End User 

Documentation written in PDF format. To review these documents point your browser to 

%TS_INST%\flexlm\doc\FNP_11.17.0_doclib.pdf 
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Testing the Installation 

Test Prerequisites 
Note when using the Insert Existing Component command CATIA V5 will reference the 

“Folder of the link” settings of the current CATIA V5 environment. Therefore to enable the 

interactive insertion of JT files the setting of the “Folder of the link” must be active. 

 

This is activated using the CATIA V5 Tools>Options>General>Document menu. Ensure that 

the “Folder of the link” is ACTIVE before interactively attempting to insert a JT file into the 

active session. 

 

CATIA V5 Interface showing the Tools>Options>General>Document Menu 
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The CATIA V5 Menu Showing the “Folder of the Link” setting Activated 

If this setting is deactivated the following error message will be reported to the screen when 

you attempt to insert the JT file into the active session 

 

The CATIA V5 Error Message generated when the “Folder of the link” setting is Deactivated. 
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Test Process 
A sample JT file is provided to test the installation of the software. The file named 

catia5_fta.jt and is located in the %TS_INST%\samples\jt directory. 

To test the installation start CATIA V5 using the modified CATEnv environment. Then using a 

new CATIA V5 CATProduct select the Insert>Insert Existing Component menu, browse to the 

sample directory and select the file catia5_fta.jt. Assuming that caching is switched on in the 

current environment CATIA V5 will display the JT file using a CGR representation. 

 

The CGR file is automatically generated in the directory specified in the CATIA V5 

Tools>Options>Infrastructure>Product Structure>Cache Management tab. Note if the CGR 

file is retained then the translation will not take place again until such time as the JT file is 

itself updated. The mechanism ensures that CATIA V5 presents the latest available 

representation of the JT data. 

If the current cache settings is switched off then the JT file would have been translated into a 

CATShape representation and stored in the current CATTemp directory. 

Following this select the item in the specification tree and then using the right hand mouse 

button menu select the option Representations>Design Mode the display will then change to 

show a CATShape representation of the JT file including the PMI data. 
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This completes the installation test. If you fail to see either of the previous pictures refer to 

Trouble Shooting to read some of the common problems that you may be experiencing. 
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Trouble Shooting – Common Problems 

 Check that the license file is called %TS_INST%\flexlm\license.dat or if an alternative 
filename is used ensure that the filename matches the setting of the environment 
variable THEOREM_LICENSE_FILE 

 

 The first line of a FLEXlm license.dat file should resemble the following 
SERVER mymachinename COMPOSITE= 0800366f1102 7601 
The information reported for mymachinename and COMPOSITE id value MUST match 
the output data generated when using the theorem_composite license manager utility. 

 

 The current system date and time should be correct. If incorrectly set, the license file 
may NOT be valid. 

 

 If you have installed the software in a non-default location then ensure that you edit the 
ts_env.csh or ts_env.bat file in the installation directory. 

 

 If when starting CATIA V5 you see a message stating that a VEL license can’t be located 
this is most likely due to old values retained in your CATSettings directory. This message 
doesn’t have a detrimental impact on the operation of the system. However to 
overcome this message being reported you can remove the complete CATSettings 
directory before starting CATIA, the CATSettings directory will then be automatically 
recreated.  

 

 If the translator fails to operate from within the CATIA V5 first check that the FLEXlm 
license process is running and then attempt to run the translator from the command 
line. Refer to the Command Line User Guide for the translator command line syntax. 

 

 When attempting to use “Insert Existing Component” CATIA V5 displays the message 
 
“Warning Insert file failed. File...\jt\catia5_fta.jt" not accessible because of Linked 
Document Location settings.” 
 
This issue is caused by the setting for the “Folder of the link” being deactivated. To insert 
JT files into an active CATIA V5 session this setting must be activated. See Section 4 
“Testing the Installation: Test Pre-Requisites” for instructions on how to resolve this 
issue.  

  

 When attempting to use Insert “Existing Component” CATIA V5 displays the message  
 
"Cannot Insert Files(s) :…..\jt\catia5.jt.  
 Insert Failed due to invalid or inconsistent extension type. Extension Type doesn't exist 
or license is not granted" 
 
The most likely causes of this message are either a typing error in the CATEnv file. Check 
all additional settings in the file, especially the setting of CATDictionaryPat which 
controls the interface between CATIA V5 and the translator. Alternatively the issue may 
be due to the fact that the nominated CATEnv isn’t being referenced when CATIA is 
starting. Check the launching of CATIA and ensure that the right CATEnv is being used. 

 


